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Section 1: Getting Started

About HotDocs Template Portal

What is HotDocs Template Portal?

HotDocs Template Portal is an out-of-the-box host application for HotDocs Server 
that provides an intuitive and secure Web interface for assembling documents from 
HotDocs templates. It includes the following features:

 User Authentication and Access Control: Template Portal's secure environ-
ment allows you to manage user access to templates, template sets and answer 
files.

 Template Uploading: You can publish your templates directly from HotDocs 
Developer. HotDocs Template Portal recognizes published templates and 
uploads them directly into the database.

 Template Management: You can create groups of templates for specific needs 
within your organization. You can also give users access to templates or answer 
files directly from Template Portal.

 Answer File Management: You can store answer files on the server and share 
answer files with other users within your organization. You can also upload 
existing answer files from the desktop to the server, and download answer files 
from the server to the desktop for offline management.
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System Requirements

Hardware Requirements

The hardware requirements for your system vary depending upon the type and 
complexity of the templates assembled. HotDocs Server performance is primarily 
bound by disk I/O speed, which means you should ensure that the disk system is as 
fast as possible. Also, additional RAM improves disk I/O speed by allowing the 
operating system to cache more files in system memory. The basic recommended 
hardware configuration is as follows:

 2 or more processors (2 GHz or faster) (Single processor machines can work 
well for development and lower load production environments.)

 1GB RAM (2GB recommended)
 SCSI or comparable storage subsystem

Software Requirements

Your system must meet the following software requirements before you can install 
HotDocs Template Portal:

 Microsoft Windows Server 2008, 2008r2, or 2012.

Note: When deploying on Windows Server 2012, it is recommended that the 
temporary directory be located on an NTFS partition rather than ReFS.

 HotDocs Server 11
 Microsoft .NET Framework 3.5 and 4.0

Note: On some operating systems, if the HotDocs Server installation program 
does not detect .NET Framework on your machine, the HotDocs Server instal-
lation program installs these elements automatically. On other operating 
systems, such as Windows Server 2008 and Windows Server 2012, you must 
manually install the .NET Framework before you install HotDocs Server

 Microsoft Internet Information Services (IIS) 6 or greater
 Access to a running SQL server where Template Portal can create the database 

for template, answer file, and user information

In addition to the requirements listed above for the server, end users who assemble 
documents using HotDocs Server must have certain software installed on their 
computers to complete browser-based interviews or view assembled documents. 
The following software is required:

 Microsoft Windows
 A Web browser capable of displaying an interview. These include Microsoft 

Internet Explorer 8 or later, Firefox, Chrome, or Safari. JavaScript interviews 
are also compatible with mobile Safari on iPads. Silverlight interviews require a 
desktop browser in which the Silverlight 5 runtime engine is installed.
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 Any word processor that can display, edit, or print an assembled text document, 
including WordPerfect® and Microsoft® Word

 HotDocs® Filler (for assembled HFD and HPD form documents) and/or 
Adobe® Reader® (for assembled PDF based form documents)
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Install HotDocs Template Portal

The process of installing HotDocs Template Portal on your Web server is handled 
by a custom installation package designed for this purpose. Like most installation 
packages, this installation consists of several wizard-like dialog boxes that gather the 
information necessary for HotDocs Template Portal to be installed correctly.

Before you run the installation package, however, you perform some preliminary 
steps. Specifically, to install Template Portal, you must:

 Create a SQL database and user account.
 Create an ODBC system data source (DSN), which Template Portal and the 

install will use to connect to the database.
 Install Template Portal.
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How do I create an SQL database and use account

HotDocs Template Portal uses a SQL database to store information about the 
templates, answer files, user accounts, etc. At run-time, Template Portal then uses 
a single SQL user account to read and write information to this database.

To create the SQL database and user account

1. Open your SQL server management console and connect to the SQL server using 
an account that has permissions required to create a new database and server 
login.

2. Right-click the Databases folder and select New Database from the shortcut 
menu. The New Database dialog box appears.

3. Enter the name of the new database (e.g., HDSPortal) in the Database name 
field, and then click OK. The new database is created and added to the list of 
databases.

4. In the Security for the SQL server (not the database), right-click the Logins sub-
folder and select New Login from the shortcut menu. The Login - New dialog 
box appears.

5. Enter a name for the new login (e.g., HDSPortalUser) in the Login name field.

6. Select SQL Server Authentication and enter a Password for the new login. (Also 
make sure that the user is not required to change the password at next login.)

7. Select the Template Portal database (created in step 3 above) from the Default 
database drop-down list.

8. Click OK. The new login is created and added to the list of logins.

9. In the Security folder for the database, right-click the Users subfolder and select 
New User from the shortcut menu. The Database User - New dialog box 
appears.

10.Enter a User name and a Login name (the login name was created in step 5 
above).

11.Select db_datareader and db_datawriter from the Database role membership 
group.

Note: If using SQL Server 2012 you will need to first select the Membership 
page, then select db_datareader and db_datawriter from the Database 
role membership group.

12.Click OK. The new user is added to the list of database users.
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How do I create an ODBC system data source (DSN)?

To create an ODBC system data source (DSN)

1. Depending on your version of Microsoft Windows Server there are two methods 
to access the ODBC Data Source Administrator:
Server 2008: Click Start > Programs > Administrative Tools > Data 

Sources (ODBC). The ODBC Data Source Administrator dialog box 
appears.

Server 2008r2 or 2012: You must create a 32-bit DSN. To do this, run the 
32-bit version of the ODBC Data Source Administrator, which you can 
find in C:\Windows\SysWoW64\Odbcad32.exe.

2. At the System DSN tab, click Add. The Create New Data Source dialog box 
appears.

3. Select the SQL Server driver you need to connect to your database, and then click 
Finish. The Create a New Data Source to SQL Server dialog box appears.

4. Type a unique Name and Description for the data source in the corresponding 
fields.

5. Select the instance name of the SQL Server on which you created the Template 
Portal database, and then click Next. The dialog box changes to show options for 
connecting to the SQL Server.

6. 6. Select With SQL Server authentication using a login ID and password 
entered by the user.

Caution
Do not select Windows authentication. HotDocs Template Portal requires a DSN that 
uses SQL server authentication.

7. Select Connect to SQL Server to obtain default settings for the additional con-
figuration options, and enter the Login ID and Password created in part 1 above.

8. Click Next The dialog box changes to show additional configuration options.

9. Select Change the default database to, and enter the name of the Template 
Portal database (see part 1 above) as the default database.

10.Click Next, and then Finish. The ODBC Microsoft SQL Server Setup dialog 
box appears, showing the configuration of the data source that will be created.

11.Click Test Data Source to ensure that you can connect to the SQL Server, then 
click OK to return to the ODBC Data Source Administrator dialog box. The 
new data source is added to the list of data sources.
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How do I install HotDocs Template Portal?

To install HotDocs Template Portal

1. Close all open applications.

2. Perform one of the following actions depending on how you received the instal-
lation package:
If you received an installation CD, insert it into the server's CD-ROM 

drive.
If you downloaded the installation package, save it to a location on the 

server's hard drive.

3. Open Windows Explorer and browse to the folder on the CD or hard drive where 
the installation package (TemplatePortal.msi) is found.

4. Double-click TemplatePortal.msi. The installation program begins installing 
Template Portal.

5. Follow the on-screen prompts to complete the installation. You will be prompted 
for information at the following dialogs:

6. After completing the installation, verify that both HotDocs Server and your Web 
site are running.

Dialog Description

Program Files Enter the folder where Setup should install the program files. By 
default, this is the same folder where HotDocs Server is installed.

HotDocs 
Server URLs

This dialog box prompts for the following information:

 User Style Sheet: This is the URL to the user style sheet (e.g., 
hdsuser.css) that will control the interview appearance.

 Images Folder: This is the URL where images used during the 
interview are found.

 JavaScript Folder: This is the URL of the HotDocs Server 
JavaScript folder.

Windows User 
Account

This dialog box lets you specify the name and password of a 
Windows user account under which Template Portal will run. You 
can use an existing user account, or create a new account.

SQL Database 
Connection 
Information

This dialog box lets you specify the system DSN the install (and 
Template Portal) will use to connect to your Template Portal data-
base. It also prompts for two different user accounts for connecting 
to the database:

 The Setup User Account is used by the install to create and 
populate the tables with default information, which requires dbo 
privileges (e.g., the sa account or any other account that has at 
least dbo privileges on the Template Portal database). This 
account may also use a trusted connection (Windows authenti-
cation) if desired.

 The Template Portal User Account is used by Template Portal at 
run-time; it is the SQL user account created in part 1 above.
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Section 2: Assembling Documents Using
Template Portal

Descriptions of Template Portal Pages

This section contains descriptions of pages used by non-administrative users.

Home (Select Template) Page

This page lets you choose a template to begin assembling a new document. The 
Items per page drop-down list allows you to select how many templates are 
displayed per page. If templates are located on additional pages, you can click a page 
number to view additional templates. To help you find a specific template, you can 
sort the list by clicking the Title or Description column headings. The Search box 
can also help you find a specific template if you know a word or phrase in its title or 
description.

Tip: Click the Home button 
at any time while logged on 
to HotDocs Template Portal 
to return to this page.

To search for a specific template

In the Search box, type some of the text that is in the title of the desired template. 
The template list changes to show only the templates that contain the text you 
typed.
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Select Answer File Page

The Select Answer File page (Select Template > Select Answer File) lets you choose 
whether to create a new answer file or use an existing file. After you complete the 
interview, you can then save your answers for use when assembling other docu-
ments.

To create a new answer file

1. Select Begin using a new, empty answer file.

2. Click Continue to display the HotDocs interview.

To use an existing answer file from your computer

1. Select Use a HotDocs answer file from my PC, then click the Browse button to 
locate an existing answer file on your computer.

2. Click Continue to display the HotDocs interview.

To use an existing answer file from the server

Select an answer file from the list of answer files stored on the server by clicking on 
the link name. (Use the Search box to find answer files containing specific text in 
the title or description.)



Section 2: Assembling Documents Using Template Portal

10

Complete Interview Page

The Complete Interview page (Select Template > Select Answer File > Complete 
Interview) gathers the answers required by the template to assemble a document. 
To help you answer the questions, the interview window is divided into three panes:

 Interview Outline: Provides an overview of the questions you must answer
 Dialog Pane: Displays the specific questions
 Resource Pane: Provides helpful information to assist you in answering specific 

questions or dialogs

Interview Outline

The interview outline lists all of the dialogs (or groupings of questions) in the inter-
view and allows you to quickly move to any dialog in the interview you need. When 
you click the name of a dialog in the outline, the dialog appears in the dialog pane 
so you can answer questions in it.

The following icons are used in the interview outline to show the answered status of 
questions in each dialog, which can help you determine which dialogs contain ques-
tions you still need to answer:

These icons and the list of dialogs in the interview outline are updated dynamically 
as you answer questions in the interview. Sometimes, especially when assembling 
large or complex documents, the time it takes to update the outline may noticeably 
slow down the interview. For example, it may take a few seconds to move from 
question to question within a dialog. You can change the interview speed by clicking 
the Enable/Disable Instant Update button. When Instant Update is enabled, the 
interview is updated as you move between answer fields; when it is disabled, the 
interview is only updated when you move between dialogs.

By default, the interview outline appears to the left of the dialog pane, but you can 
change its width or position as needed:

 To change the width, drag the border separating the interview outline and 
dialog pane to the desired width.

None of the questions in the dialog are answered.

A new repetition of a repeated dialog in which none of the 
questions are answered.

At least one of the questions in the dialog is answered.

All required questions in the dialog are answered.

The dialog contains at least one unanswered required ques-
tion.

The dialog contains at least one unanswered required ques-
tion.
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 To close the interview outline, click the Close button in the upper right corner 
of the interview outline. (To show it again, click the Interview Outline tab on 
the left side of the interview.)

Some options may not be available in all situations. For example, template providers 
may require that Instant Update always be enabled, or they may choose not to allow 
you to view the interview outline.

Dialog Pane

Questions you must answer are presented in dialogs. Some questions appear repeat-
edly--either as a series of dialogs or as a spreadsheet. This allows you to enter 
multiple answers for a single question, thereby creating a list of answers. Finally, 
some questions appear in a nested dialog. Nested dialogs usually represent questions 
that are either dependent on or related to questions in the main dialog. They usually 
appear as an icon directly on the main dialog, but they can also appear as a spread-
sheet on the main dialog.

The following table shows how to navigate through dialogs and answer various types 
of questions:

To Do This

Answer text fields Enter your answer in the text field.

Answer check 
boxes or option 
buttons

Either select the check box using the mouse, or press the 
space bar.

Answer dates Click the Calendar button and choose a date from a cal-
endar. You can also enter the letter T for today's date or 
enter a date in one of the following formats: 6/3/90, 06/03/
1990, June 3, 1990, 3 June 1990, and so forth.

Answer questions 
when the dialog is 
asked repeatedly

Answer all the questions in a dialog, clicking Next to get to 
each repetition. When you are finished entering all of the 
different sets of answers, click Next at a dialog without any 
answers.

Answer questions 
in a repeated 
spreadsheet

Enter each set of answers on a its own row in the spread-
sheet. To edit a row of answers, click Edit Row. To insert a 
new row between existing sets of answers, click Insert 
Row. To remove a set of answers, click Delete Row.

Answer questions 
in a nested dialog

Click the dialog icon. When you finish answering its ques-
tions, you can either click the button in the navigation 
bar or click the main dialog in the interview outline.

Go to the next or 
previous dialog

Click either the button or the button. (You can 
also press Page Down/Page Up or Alt+N/Alt+P.)
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Resource Pane

Sometimes, the template provider includes resource text (or information) that can 
help you answer questions in a dialog. For example, reading a relevant statute may 
help you know how to answer a particular question. When resource text is available, 
it appears in the resource pane, which is located just below the dialog pane.

To show or hide the resource pane, click the Show/Hide Resource Pane button. 
When the resource pane is shown, you can see resource text for the current question 
in the dialog. (If a question does not have resource text available, the resource pane 
is empty.) In addition, you can click the View Resource button next to any 
question with resource text to view its resource text in a separate window.

Note
The resource pane may not be available in all situations. For example, template pro-
viders may choose to permanently hide the resource pane for a template.

Go to the next 
dialog or the 
previous dialog that 
contains an unan-
swered question

Click either the Next Unanswered Dialog button or the 
Previous Unanswered Dialog button. (You can also 

press Ctrl+Page Down/Ctrl+Page Up.)

Go to the first or 
the last dialog in 
the interview

Click either the button or the button. (You can 
also press Alt+R/ Alt+L.)

Finish the interview Click the button.

Save Answers As you answer questions during the interview, you may 
want to save your answers in an answer file. To do this, click 
Save Answers. You will then be prompted to enter the 
information required for saving the file.

Preview Assembled 
Word Documents

If you are assembling a Word document, you can preview 
the document at any time during the interview. To do this, 
click the Document Preview button. To return to the inter-
view to continue answering questions, click Back to Inter-
view.

To Do This
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Save/Download Page

The Save/Download page (Select Template > Select Answer File > Complete 
Interview > Save/Download) lets you save your answers and assembled document 
when you complete an interview.

Note
If you did not finish answering all of the questions in the interview, click Return to 
Interview to go back to the interview and enter the missing information. Questions 
requiring answers to complete the document are marked in red.

To save your answers on the server

1. Click Save Answers. The Save Answer File dialog box appears.

2. Enter an Answer File Title and Answer File Description for the answer file.

3. Click Save. The answer file is saved on the server.

Note
To make a copy of an existing answer file and assign it a new name, click Save Copy.

To save your answers locally (on your computer)

1. Click Download Answers. The File Download dialog box appears.

2. Click Save. The Save As dialog box appears.

3. Choose a folder where the answer file will be saved, specify a new file name if 
desired, then click Save. The answer file is saved to your local computer.

To download the assembled document

1. Click Download for the document you want to download. The File Download 
dialog box appears. (Optionally, if assembling a Word document, select PDF to 
download the assembled document in PDF format before clicking Download.)

2. Click Save. The Save As dialog box appears.

3. Choose a folder where the document will be saved, specify a new file name if 
desired, then click Save. The document is saved to your local computer.

Note
If multiple documents are generated by the template set, a message indicates how 
many interviews will be presented to complete the document set. Click Next Inter-
view to proceed to the next interview.
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View User Profile Page

The View User Profile page (Manage > My Profile) lets you view or edit your user 
information. For example, you can change your password or view the user groups 
to which you belong.

The following information may only be viewed (not modified) at the View User 
Profile page:

 Last Name
 First Name
 User Role
 Group Membership

The other information, E-mail and Password, may be changed as described below.

To change your e-mail address

1. Enter a new e-mail address in the E-mail box.

2. Click Save. The address is saved and the Home (Select Template) page appears.

To change your password

1. Enter your new password in the Change Password box.

2. Re-enter your new password in the Verify Password box.

3. Click Save. The new password is saved and the Home (Select Template) page 
appears.
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Answer File Management Page

The Answer File Management page (Manage > My Answers) lets you manage 
answer files stored on the server. For example, you can edit the title or description 
of an answer file, upload an answer file to the server from your local computer, or 
delete an answer file from the server.

To help you find a specific answer file, you can sort the list by clicking the Title, 
Description, File Name, or Last Modified column headings. You can use the 
Search box to find a specific answer file if you know a word or phrase in its title or 
description. The Items per page drop-down list allows you to select how many 
answer files are displayed per page. If answer files are located on additional pages, 
you can click a page number to view additional answer files.

To edit answer file properties

1. Click Edit for the answer file you want to edit. The Edit Answer File dialog box 
appears.

2. Enter a new Answer File Title, Description, or File Name.

3. Optionally, select the user groups with which you want to share the answer file.

4. Click Save. The answer file properties are saved.

To upload an answer file to the server

1. Click Upload Answer File. The Upload an Answer File dialog box appears.

2. Click the Browse button. The Choose file dialog box appears.

3. Select the answer file you want to upload to the server, then click Open. The 
answer file name and path is inserted in the Choose answer file to upload box.

4. Enter an Answer File Title and Description.

5. Optionally, select the user groups with which you want to share the answer file.

6. Click Save. The answer file is uploaded to the server and added to the list of 
answer files.

To download an answer file from the server

1. Click Download for the answer file you want to download. The File Download 
dialog box appears.

2. Click Save. The Save As dialog box appears.

3. Choose a folder where the answer file will be saved, then click Save. The file is 
saved to your local computer and the Download complete dialog box appears.

To delete an answer file from the server

1. Click Delete for the answer file you want to delete. A dialog box appears which 
asks if you are sure you want to delete the answer file.

2. Click OK. The answer file is deleted and removed from the answer file list.
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Section 3: Managing Template Portal

Template Portal Administration

Most of the Template Portal administrative tasks, such as adding and removing 
users or assigning templates to groups of users, may be performed by logging on to 
the site as an administrator and making changes through the Web interface.

Once logged on, you can click the Help button on any page to view step-by-step 
instructions for completing tasks on that page. As an administrator, you can manage 
answer files, template files, users, and user groups. You can also view a report of 
usage statistics. Information about performing these tasks is contained in the online 
Help pages.

Note
Some administrative tasks cannot be performed through the user interface. These 
tasks include file management and enabling or disabling Windows authentication and 
PDF conversion. Steps for completing these tasks are listed below.

How do I log on to Template Portal?

Before completing any other tasks, you must first log on to Template Portal. Once 
you are logged on, you can you can assemble documents, manage answer files, and 
view your personal profile information. In addition, users with administrative rights 
can also manage templates and user accounts.

To log on to Template Portal

1. Open Internet Explorer and enter the URL (e.g., http://www.domain.com/hds-
portal) in the Address box. (The last part of the URL, hdsportal, will always be 
the same, but you must replace www.domain.com with your own domain or 
computer name.) When the page appears, you will see the User Authenitcation 
page where you can log on.

2. At the User Authenitcation page, type your user name and password in the User 
Name and Password boxes.

Note
The default administrator user account name is admin, and its password is also admin.

3. Optionally, click Remember Me to automatically log on in the future.

4. Click Log On. The Select Template page (the “Home” page) appears.

5. Optionally, select Manage > My Profile to change the password. (This is recom-
mended the first time you log on.)
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How do I manage template and answer files?

Template and answer files may be deleted from the database using the Web inter-
face, but this does not delete the files from the server itself. These files are stored in 
the Files subfolder on the server (e.g., C:\Program Files\HotDocs Server\Template 
Portal\Files) and may be deleted as necessary.

How do I enable Windows authentication?

Template Portal supports Windows authentication, which means users may use 
their own Windows user name and password to log on to Template Portal, rather 
than using a separate user name and password specific to Template Portal.

To enable Windows authentication in Template Portal

1. Edit the Template Portal web.config file (e.g., C:\Program Files\HotDocs 
Server\Template Portal\HDSPortal\web.config).

2. In the appSettings section, set the UseWindowsIdentity key to true.

3. Optionally, change the NewWindowsUsersGroup key value to the name of a 
Template Portal user group to which all new users will be assigned by default. 
(The default value is Users.)

4. Save your changes to web.config.

5. In the Template Portal program files folder (e.g., C:\Program Files\HotDocs 
Server\Template Portal), right-click the HDSPortal folder and select Properties 
from the shortcut menu.

6. At the Security tab, give each Windows user or group of users Read permissions 
to the folder.

7. Repeat steps 5–6 to give each Windows user or group of users Read permissions 
to the Files folder.

8. In the IIS management console (Start > Programs > Administrative Tools > 
Internet Information Services), browse to the HDSPortal virtual directory on 
your Web site.

9. Right-click the HDSPortal virtual directory and select Properties from the 
shortcut menu.

10.At the Directory Security tab, click Edit from the Anonymous access and 
authentication control group. The Authentication Methods dialog box appears.

11.Clear the Anonymous access check box, and select the Integrated Windows 
authentication check box.

12.At the Component Security node of the HotDocs Server Management Console 
(Start > Programs > HotDocs Server > HotDocs Server Management), grant 
each Windows user or group of users permission to access the HotDocs Server 
COM objects.
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How do I enable PDF conversion?

Template Portal has the ability to invoke PDF conversion utilities to convert assem-
bled RTF documents to PDF. HotDocs Server includes a built-in PDF conversion 
utility, but you can also choose to use one of two supported third-party conversion 
utilities: Neevia Document Converter Pro and activePDF DocConverter. Using 
this PDF conversion feature, you can let users decide whether to download the RTF 
or PDF version of an assembled document, or you can force all RTF documents to 
be converted to PDF before they are downloaded.

To enable PDF conversion in Template Portal

1. Edit the Template Portal web.config file (e.g., C:\Program Files\HotDocs 
Server\Template Portal\HDSPortal\web.config).

2. In the appSettings section, set the PDFConverterName key to one of the follow-
ing values (you can just uncomment the appropriate statement):
HotDocs
ActivePDFServer
NeeviaDocumentConverter

Caution
The built-in HotDocs PDF converter analyzes the codes contained in the RTF file and 
translates them to PDF. This differs from the method used by other third-party PDF 
converters, which rely on an instance of Microsoft Word on the server from which the 
document is “printed” using a driver to create the PDF document. PDF documents 
created using a PDF driver can typically handle a greater number of formatting varia-
tions, while the PDF conversion method used by HotDocs Server works best for docu-
ments with simpler formatting. If you use HotDocs Server's built-in PDF conversion, 
some formatting differences will exist between the original RTF and the PDF.

3. Optionally, to force all RTF documents to be converted to PDF, set the Conver-
tAllRTFDocumentsToPDF key value to True. (If this key is False, or com-
mented out, PDF conversion is optional for each assembled document.)
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4. Configure the selected PDF converter as follows:

5. Save your changes to web.config.

Option Description

HotDocs If you want to password-protect the PDF files, you can 
specify values for one (or both) of the following keys:

 HotDocsPDFUserPassword
 HotDocsPDFOwnerPassword

Note
The user password controls view access to the PDF file, while 
the owner password controls print and edit access. By 
default, these passwords are empty strings (“”), which do not 
password-protect the PDF files.

ActivePDFServer Set values for the following keys (referring to your active-
PDF documentation for information about appropriate 
values):

 ActivePDFServerAddress
 ActivePDFServerPort

NeevialDocument-
Converter

Ensure that Neevia is configured to look in the folders speci-
fied by the following keys:

 PDFDocumentErrorFolder
 PDFDocumentOriginalsFolder
 PDFDocumentOutFolder
 PDFDocumentInFolder

Also, set the following additional values as needed (referring 
to your Neevia

documentation for information about appropriate values):

 PDFConverterTimeout
 PDFScriptSrc
 PDFScriptLang
 PDFLinearized
 PDFScriptTimeout
 PDFPaperSize
 PDFPaperOrientation
 PDFTopMargin
 PDFBottomMargin
 PDFLeftMargin
 PDFRightMargin
 PDFDocumentResolution
 PDFCompatibilityLevel
 PDFAutoRotatePage
 PDFCompressPages
 PDFEmbedAllFonts
 PDFSubsetFonts
 PDFFontsMaxSubset
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Contact HotDocs

Technical Support Contact Information

For customer inquiries, including technical support issues, contact the HotDocs 
Professional Services team.

Outside the European Union:

Inside the European Union:

Additionally, you may find answers or solutions to questions you have in the 
HotDocs Wiki. To view the Wiki, please visit http://wiki.hotdocs.com.

Method of Contact Information

Telephone (800) 828-8328 (U.S.)

(801) 615-2200 (International)

Note
Technical support is available from 7:00am to 
6:00pm (MST), Monday through Friday.

E-mail support@hotdocs.com

Web Site http://hotdocs.com/support/

Address 387 S 520 W, Suite 210

Lindon, UT 84042

USA

Method of Contact Information

Telephone 0843 208 0704 (U.K.)

+44 131 220 9027 (International)

Note
Technical support is available from 9:00am to 
5:00pm (GMT), Monday through Friday.

E-mail tech@hotdocs.co.uk

Web Site http://hotdocs.com/support/

Address 14 South Charlotte Street

Edinburgh, EH2 4AX

Scotland
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Documentation Feedback

To improve the quality of the help file, we invite you to make comments or sugges-
tions. When doing so, please include as much information about your experience 
using the documentation as possible. For example, if commenting about a specific 
topic, include the name of the topic in your feedback.

E-mail your comments and suggestions to publications@hotdocs.co.uk.

Note
The HotDocs Publications team cannot respond to technical support or project consult-
ing issues. We are mainly interested in problems with the documentation itself—such 
as erroneous information, grammatical and spelling errors, or suggestions for topics 
to include in the next release of the software.
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